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        Skycut Series CH with SignMaster Pro 
 

September 26, 2020 
 

 
 
 
Do NOT read this entire manual… unless you want to.   

• At the start of Chapters 1 - 4 are short sections with references to find what you need plus some important 
reminders.  PLEASE read these short sections at the very least and refer back to them, when needed. 

• Chapters 1 and 2 are very important in terms of correctly setting up your Skycut to work with SignMaster 
and learning the ins and outs of cutting. 

• Chapter 3 is for those owners wanting to perform print and cut applications. 

• Chapter 4 covers using the Skycut accessory tools. 

• Chapter 5 covers several SignMaster functions of interest: creating contour cuts and engraving fills  

 
It’s not practical to print this entire manual because: 

• It’s a waste of paper and ink if you only ever need certain sections. 

• The live links to videos and web sites in the manual will not work. 

• This manual will be updated from time to time. 

• You cannot search on individual words. 

 
Also: 

• Note the green  icons which link to videos related to the section in which they are located. While 
some of the videos were made using the original Skycut C model, the information contained will apply to 
your Skycut CH and should enhance your learning experience. 

 
 

 

 

________________________________________________________________ 
 © 2018-2020  Sunrise Electronic Technology Co., Ltd.  All Rights Reserved 
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1. Introduction and Setting Up 
 
 

1.00 Quick Reference for This Chapter 

• How to download and set up SignMaster:  Section 1.11 

• How to set up communication between a computer and Skycut: Section 1.12 

• How to use the control panel: Sections 1.10 and 1.14 

• How to adjust the blade holder: Section 1.07.3 

• Where to position the pinch wheels: Section 1.09 

• The cutting mat is too sticky (or not sticky enough): Section 1.08 

• How to use the USB Flash Drive feature: Section 1.12.4 

 

Important Notes: 

• Please read Section 1.02 regarding safe operation of the Skycut. 

• Report any damage or missing contents to your dealer promptly. 

• Retain the original box and packing materials in case you ever need to ship your Skycut. 

 

 

1.01 Support 

• Thank you for choosing a Skycut digital die cutter. Before using a blade in your new cutter, we urge you to 
read Chapters 1 and 2 and watch the videos linked in these chapters. 

• If you run into difficulties with the operation of your Skycut, turn off the power and look for a solution in this 
manual. Note that Appendix A is a Troubleshooting section.  If you continue to have technical questions or 
issues, please contact your dealer as soon as possible. 

• If anything is missing from your order or you have mechanical issues with your Skycut, please contact your 
dealer as soon as possible. You can also contact Skycut directly using this email address: 
skycut@skycut.cn.  

• For additional information and support with the Skycut, please check out the following: 

◊ Skycut web site: http://www.sky-cut.com/ 

◊ Skycut Facebook page: https://www.facebook.com/skycutcuttingplotter/ 

◊ Skycut Facebook group: https://www.facebook.com/groups/Skycut/ 

◊ Skycut YouTube channel: https://www.youtube.com/channel/UCrPn5hFLbiRNDgccY8iXwoA 

• For SignMaster support, please go to http://signmaster.software/support/ 
 
 

1.02 Safety and Warnings 

Please be aware of the following safety guidelines when working with the Skycut: 

• Pinch Points:  Keep hands, long hair, loose clothing, jewelry, etc. away from the moving parts. 

• Risk to Children and Pets:  Please supervise children around the cutter when it is in use.  

• Movement and Touching:  Do not move the Skycut or touch any circuitry while it is plugged in.  
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• Power Adaptor: ONLY use the included power adaptor. Attempting to use a different model can result in 
seriously damaging the Skycut. If either the power cable or adaptor are damaged, replace with the 
appropriate parts. 

• DO NOT touch or jam the plotter’s track while it is operating. If the cutter is damaged, it is the owner’s 
responsibility. 

• DO NOT shake the cutter while it is operating. 

• DO NOT cut any materials that have staples or other embellishments attached. 

• DO NOT touch the cutter with a magnet. It is safe, however, to cut magnetic materials, such as those used 
on refrigerators and car exteriors. 

• DO NOT allow any liquids to spill into the cutter. 

• DO NOT allow small items to fall into the cutter. 

• Place the Skycut on a sturdy and stable table, desk, or trolley. The optional Skycut stand can also be used.  

• Always turn off the Skycut when not in use. Leaving the cutter turned on for extended periods of time can 
possibly damage the machine. 

• Always turn off the Skycut before unplugging the power adaptor or removing the power cable from the wall 
outlet or power strip. 

• Unplug the Skycut from a wall outlet or power strip during an electrical storm or when the cutter will not be 
used for an extended period of time. 

• Transporting: When transporting the cutter, move the pinch wheel lever into the upward position. Remove 
the blade from the blade holder and cover the tip with the plastic cap.  

 
 
 

1.03 Warranty 

• IMPORTANT! If your Skycut is damaged during shipment or appears to be defective, your dealer should be 
notified as soon as possible.  

• For additional information regarding your warranty, please refer to your Skycut dealer.  

• It is recommended that you retain the original box with packing materials in case you ever need to ship your 
Skycut. 

 
 
 

1.04 Unpacking        

• Verify that you have received all contents. There is a checklist in Section 1.05. Please notify your Skycut 
supplier immediately if anything is missing. 

• Remove all foam pieces and other packaging before turning on the Skycut. Currently, the cutter ships with 
two end cap foam protectors and one small foam piece tucked under the head. There are also three plastic 
zip ties that will need to be cut. Be very careful to only cut those ties and NOT the black cable behind them. 

• Because the cutting mat must be folded over to fit into the box, it may have become slightly rounded during 
shipping. Gently and only partially roll the mat in the opposite direction to remove the roundness and place 
on a flat table to make sure the mat now lies horizontally to the surface.  Refer to Section 1.08 for additional 
instructions on preparing the mat for use. 

• Use the enclosed test pen as you experiment and become familiar with operating the Skycut. Place scrap 
paper on the mat and simply draw shapes rather than cut them. This will prevent possible damage to the 
blade, mat, and cutting strip as you learn where shapes will cut and the basic operating procedures. 
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1.05 Contents      

• Besides the cutter, your box should also contain the following items: 

# Description Image Quantity

1 Power Supply 1

2 Power Cable 1

3 USB Cable 1

4 60° Blade(blue cap) 1

5 45° Blade(red cap) 2

6 Blade Holder 1

7 Test Pen and 1 Refill 1 set

8 Cutting Mat 1
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1.06 Parts of the Skycut       
 

Front 
 
 
 

 
 

                      

• Alignment Arrows: indicate to the user the available positions for the pinch wheels 

• Blade Carriage: moves the Blade Holder Seat left and right 

• Blade Holder Seat (Jaw): holds the blade holder, test pen, and other accessories 

• Control Panel: used to change settings, set up Wi-Fi, calibrate camera, cut PLT files, and more 

• Cutting Strip: protects a blade when cutting backed materials without using a cutting mat 

• Grit Shafts (3 on 16” model; 4 on 24” model): allow the pinch wheels to grip the mat or material so they can 
be moved in and out of the cutter during cutting 

• Pinch Wheels (3 on 16” model; 4 on 24” model): grip the mat or material so that the grit shafts beneath will 
feed the mat or material in and out during cutting 

• Pinch Wheel Lever: lifts the pinch wheels up for loading the mat or material and then lowers the pinch 
wheels for cutting 

• Power Button: turns cutter on or off 

 

 
Right Side 

 
 

 
 
 

Power Port 

USB Flash 
Drive Port 

USB Port 

Alignment Arrow 
(white triangle Pinch Wheel 

Control Panel 

Left  
End Cap 

Right 
End Cap 

Blade 
Carriage 

Cutting Strip 
(lt. gray) 

Grit Shaft (dk. 
gray and rough) 

Blade Holder Seat 
(aka Jaw)  

Pinch Wheel Lever 

• USB Flash Drive Port: used to load PLT files via control 
panel for cutting 

• USB Port: option to connect computer to Skycut with 
included USB cable 

• Power Port: connect Skycut power adaptor 
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Back 

 
 

 
 
 
 
 

1.07 Accessories 
 

1.07.1 Test Pen      
 

• The test pen should be used until you are comfortable with the operation of your Skycut and know, with 
certainty, where images will cut. The test pen should arrive pre-assembled. However, if you need to change 
out the insert, note how the test pen is assembled:  

 

 
 
 
 
 
 
 
 

1.07.2 Skycut Blades 

• There are three kinds of blades that fit inside the Skycut blade holder:  

 

 

◊ The 450 red capped blade is suited for cutting thinner materials such as paper, all cardstock types, heat 
transfer vinyl, and wall/auto/decal vinyl.  

◊ The 600 blue capped blade is a much longer blade and is well-suited for cutting thicker materials, such 
as gum paste, craft plastic, craft foam, and rhinestone template material. 

◊ Sold separately is the 300 yellow capped blade. It is a wide blade and is well suited for cutting fabric, 
felt, and tint. It has been reported that it also works well with cardstock that has been exposed to 
humidity. 

 Red             Blue        Yellow 

Pinch wheel lever Pinch wheels 

Spring goes over the top of the 
pen insert and stops at a small 
ridge on the insert 
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• Note that the red capped blade and blue capped blade have a cutback on the opposing side of the blade 
(right side, in the earlier photo). This reduces the blade offset value and allows for better detailed cutting of 
small shapes.   

• Additionally, there are other tools sold separately, including a stand, an engraving tool and an 
embossing/scoring tool. Details on the engraving tool and embosser are covered in Chapter 4. 

 
 

1.07.3 Blade Installation  

• The blade must be carefully inserted into the blade holder.  Do this over a soft surface (e.g. over a hand 
towel). It’s important to protect the fragile blade!  To install, follow the numbered steps as shown: 

  

 

 

 

 

 

 

 

• The Blade Length (also called Blade Exposure) is how much blade is exposed at the bottom of the blade 
holder.  For optimal cutting, you want this length to match the thickness of the material or be just a tiny bit 
longer.  

• When setting the blade length (Step 4 in the prior photo), hold the blade holder up next to the material 
before pressing the material to the mat, so that you can more accurately set the length to match the 
thickness of the material. For really thin materials, like vinyl and thin paper, just the very tip of the blade will 
be protruding from the bottom of the blade holder. In fact, you should just barely be able to feel it with your 
fingertip and not be able to see it very well, if at all. Having the blade fully extended will never result in better 
cutting. In fact, it can cause skewing, tearing of the material, damage to the blade, and damage to the mat.  

• A good way to test your blade length is to fold a piece of the material onto itself and then cut a line into the 
material by hand. Press firmly but not too hard, as more force will not determine if the blade is set to the 
right length. If the blade cannot cut through the material, you will need to extend the blade. If the blade cuts 
through the material and cuts into the next layer, you need to retract the blade. If the blade cuts through the 
material but does not cut into the layer below, you have the perfect length.  

 

  

 

• When conducting a test cut, be sure to check your mat (or the top of a backing sheet) for cut lines after the 
test. You should be able to set the length to get clean cuts but with only fine lines or no lines in the mat or 
backing sheet. If you do see deep cut lines, retract the blade length ~¼ of a turn counterclockwise. Repeat 
your test cut. 

 
 

3. Turn the brass ring 
counterclockwise until 
loosened. 

4. Turn the large ring clockwise or counter 
clockwise to set blade length to match the 
thickness of the material being cut. 

5. Turn the brass ring clockwise 
until locked back in place. 

1. Push in this button 
and hold so that a blade 
can be inserted OR 
removed. 

2. Gently insert non-sharp end 
of the blade into the holder. 
An internal magnet will pull 
the blade inwards. 
 
Then release button on top of 
holder 

Mat 

Material 

 Perfect Length                 Too Long                            Too Short  
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1.08 Preparing and Caring for the Cutting Mat 
 
 

1.08.1 Tips on Using the Cutting Mat 

• Always use a mat to hold the material to be cut unless the material has its own protective backing. For 
example, vinyl and iron-on transfer both come with a layer that you do not cut. Thus, this backing layer 
serves as the carrier for cutting.  Paper and cardstock do not have a backing, thus they must be cut on the 
mat. 

• IMPORTANT!  A new mat may be too sticky if you are cutting certain products. This can cause difficulty in 
removing cut items without tearing. Place an old but clean bath towel over the surface of the mat and press 
with a brayer or rolling pin.  Then pull up. Test the stickiness by pressing the palm of your hand in the middle 
of the mat and lifting. If the mat remains stuck to your hand, repeat until the mat can still be lifted but will 
release. It should only take a few pressings to greatly reduce the stickiness, as tiny (too small to be visible) 
fibers from the towel are added to the surface. 

• Do not leave the pinch wheels in a down position when the Skycut isn’t in use. This warps the plastic 
sooner, shortening the useful life of the cutting mat.  

 
 

1.08.2 Cleaning and Replenishing the Cutting Mat 

• When mats begin to lose their stickiness, they can be washed: 

◊ Use a mild dishwashing detergent, warm water, and a soft brush to thoroughly clean the surface. You’re 
not trying to scrub the adhesive but just wet the invisible fibers that have been deposited from your 
cutting materials and get them released from the glue. 

o Rinse well, shake off excess water, and place sticky side down onto a bath towel.  

o Thoroughly dry the non-sticky side of the mat with another towel.  

o Pull the mat up and the sticky side should now be dry enough for immediate use. Test by making 
sure the mat will stick to your hand.  

• While washing with soap and water should revive the original adhesive, you can add more adhesive if 
necessary:  

◊ Virtually any repositionable adhesive may be used on the cutting mat. Some of the popular choices 
include: Krylon Easy Tack, Aleene's Tack It Over and Over (view the video at the start of this section), 
Crafter's Companion Stick and Spray, Zig 2 Way Glue with wide tip, Craft Smart Off 'N On, and Scotch 
Repositionable Craft Stick. There’s another spray adhesive, Scotch Super 77, which does not leave a 
sticky surface but is excellent for stabilizing paper and cardstock.  

◊ If you are cutting thicker materials, such as oil board or styrene, then you may want to experiment with a 
stronger adhesive and use painter’s tape to secure the material to the mat. If you are cutting thin paper, 
then you may want to experiment with a lighter adhesive.   

◊ With most repositionable adhesives, you can control the tackiness based on the amount applied. Thus, 
always add a little bit at a time.  As mentioned above, if you add too much, just apply a layer or two of 
cotton fibers by pressing with a bath towel.  

• Other reported methods for cleaning mats: 

◊ Use a plastic scraper (an old credit card will suffice) to scrape off any random material pieces remaining 
on the mat after a cut.   

◊ For finer particles of paper or lint, you can use a lint roller. Tear off a sheet and then press down and pull 
up across the surface of the mat to clean in sections. Baby wipes can accomplish the same task. 

◊ To completely remove adhesive from the mat, apply Goo Gone, Duck Adhesive Remover, or Avon’s Skin 
So Soft Bath Oil across the surface. Allow a minute to soak in and then scrape off with a sharp metal 
spatula. Repeat, as necessary until the mat is thoroughly clean and no longer sticky. Wash, dry and then 
add any repositionable adhesive.  
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• When necessary, the rubber wheels and the grit shafts may be cleaned with isopropyl alcohol or Un-Du. 
Apply the cleaner to a clean lint-free rag and rub the entire wheel and/or grit shaft until free of adhesive.  

 
 
 

1.09 Pinch Wheels      

• The pinch wheels can be raised and lowered using the pinch lever located at the back-right side of the 
machine. Press down on the lever and the pinch wheels will be raised. Pull the lever up to lower the pinch 
wheels so that they can grip the mat or the material inserted in the cutter. 

• There is also a small black lever on each individual pinch wheel. When the lever is raised, there is less 
downward pressure exerted. IMPORTANT: Only push these small levers down when an extra tight grip is 
needed, such as when cutting reflective file or thick chipboard. For normal cutting of most materials, it will 
not be required. 

 

  

 

• Note that for a pinch wheel to grip properly, it must be positioned over a grift shaft. To facilitate alignment, 
note the white arrows positioned along the horizontal bar below the cover.  Slide the pinch wheels along the 
bar, as needed.  

 

• When using the cutting mat, it is recommended that the material be placed in the middle of the mat and the 
left most pinch wheel moved to the far-left side. Then slide the middle pinch wheel to serve as the left side 
grip and the right pinch wheel left in the far-right position as shown in the following photo. This keeps the 
pinch wheels off the material and provides an equal balance while the mat moves in and out during cutting: 

 

Wheels should be centered 
under white arrows  

Lever is in up position. 
This is recommended 
for most cutting. 

Lever is in down position. Do 
NOT use this position except 
with certain materials.   
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• Note that if your material is very wide, then it is fine to have the pinch wheels over the material. However, 
you may need to be extra careful when removing any cut shapes or waste material in those locations. 

 

 

1.10 Control Panel      

• When you first turn power on the Skycut, after several seconds, the following Main Screen or Home 
Screen will be displayed: 

 
 

 
 

• Throughout this manual, the functions above will be referenced along with submenus and additional 
screens.  You will also see the following icons at the bottom of many screens. Pressing the one on the left 
will always return you to the Main Screen above.  Pressing the one on the right will return you to the prior 
window/screen. 

 

 
 
 

1.10.1 Set Screen 

• Pressing the Set icon  opens the Set Screen which contains access to many functions and settings. 
Note the general description and section number (if you wish to learn more about that function now):  

 

Repeat last cut. While cutting, this icon and function changes to Pause.   

Open and cut PLT files from an 
inserted USB flash drive 

Execute a test cut using current 
speed and force settings 

Set the desired speed and force. 

Toggle the speed for moving the head and 
pinch rollers. In slow mode, the icon 

changes to:  

4 arrow keys for moving the 
head left/right and for moving 
the pinch rollers 

Stop and cancel the 
current cut 

Change settings 
Refer to 1.10.1 

Go back to Main 
Screen/Home Screen 
 

Go back to prior screen   

Middle pinch wheel is 
under left-most arrow 
 Right pinch wheel is under 

white arrow on right side.   

Left pinch wheels is on 
far left side (not in use) 
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1.11 Registering and Installing SignMaster 
 

1.11.1 Installing from a Download 

• Once you have purchased a registration for SignMaster, the software can be downloaded from the following 
link. It’s important to use this link so that the Skycut will be installed as the cutter of choice. You will need 
your Product Serial Number that was sent to you. Since you’ll also need this number every time you 
update the software, keep this number in a safe place. 

https://signmaster.software/smc.htm 
 

• Note where the file will be saved on your computer so that you can later browse to that folder and launch 
the .exe file which has been downloaded.   Follow the steps in the following Section 1.11.2, starting with 
Step (4).  

 

1.11.2 Installing from a CD 

(1) Remove the CD from the case and insert into the CD ROM drive on your computer. 

(2) The downloaded file is in.exe format, thus ready to launch.  

(3) If Windows Autorun does not initiate a welcome screen, use Explorer to locate and click on the DVD drive 
letter for your computer. Double click on the Welcome file and the following window will open: 

 

(4) Click on Install Software and wait for the installation program to open.  Select the language you prefer: 

Set up wireless connection to home 
or office network: Section 1.12.2 

Version numbers, software 
selection, reset: Section 1.14.3 

Calibrate and use camera for print 
and cut applications: Chapter 3 

Array setup, SignMastere, and options 
for display and cutter behavior: 
Section 1.14.2 

Set end-of-cut options: Section 
2.06  

Settings for: LED, Units, 
Language, Screensaver, Alarm: 
Section 1.14.2  

Click on Install Software
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(5) Read and accept the license agreement: 

 

(6) Enter the Product Serial Number which should have been sent to you by email when you purchased 
SignMaster. Note that since you will need this same number any time you update the software, keep it in a 
safe place: 

 

(7) Read and accept a second license agreement and then verify the destination for installing SignMaster: 

Select preferred language 
and click on OK 

Enter the 20-digit PSN 
provided when you 
purchased SignMaster 
and click on Next 

Read the agreement, click 
on the accept option and 
click on Next 
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(8) Select your preferred Units but note that it can easily be switched once the software is open: 

 

(9) Select SKYCUT C16 (or the model you have purchased) from the drop-down menu: 

 

(10) In the next window, you’ll have the option to create a desktop icon and install a thumbnail previewer. Both 
are recommended.  

Note where the program 
will be installed and click 
on Next 

Select preferred Units 

and click on Next 

Select the Skycut model 
you have purchased and 
click on Next 
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(11) At this point, files will be extracted and installed. Wait for the Installation Complete message and click on 
OK: 

 

(12) Then the final Finish message will appear and you can choose to open SignMaster or wait: 

 

• If you run into any issues installing or activating the program, please visit this link: 

http://www.iifuture.net/faq/index.php?action=show&cat=44 

• You may wish to periodically visit the link provided for SignMaster at the beginning of Section 1.11.1 to 
download and install any new updates.  

 
 
 

Select preferred options and click 
on Next 

Click on OK 

Click on Finish 

Leave checked if you wish to 
open SignMaster now 
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1.12 Connecting the Skycut to Your Computer      

• Place your Skycut on a sturdy horizontal surface. If using the cutting mat, be sure to allow enough free room 
in both the front and the back for the mat to extend during cutting. 

• Powering On:  

◊ Connect the power cord to the power adaptor.  

◊ Plug the power cord into a wall outlet or power strip. Then plug the power adaptor into the right side of 
the cutter.  

◊ Turn on the power using the power button below the control panel. After several seconds, the light 
inside the Skycut will turn on and the head will do a slight jog. 

• Powering Off:  Press and hold the power button until the light shuts off.  

• You have four options for sending files and information from your computer to the Skycut:  

◊ Direct USB using the included USB cable 

◊ Wi-Fi – adding the Skycut to a home/office network that is also accessed by your computer 

◊ Wireless Standalone – connecting wirelessly to your computer 

◊ U_Disk - Exporting PLT files from SignMaster onto a USB flash drive and then loading those files using 
the control panel on the Skycut.  

• Review the information in the following table to understand the differences between these options:  

Connection Options for the Skycut with SignMaster Pro

Option USB Wireless to Network (Wi-Fi) Wireless Stand-Alone USB Flash Drive

Description The Skycut is connected to the 

computer via a USB cable

The Skycut is wirelessly 

connected to a network router

The Skycut is wirelessly 

connected to the computer.

Files are saved in PLT format 

from SignMaster to a USB flash 

drive

Requirements USB cable (included) Wireless network router and 

knowledge of router's name 

and password

Computer must have wireless 

capability

USB flash drive

Pros Easy to install; Reliable and fast 

form of communication.

Skycut can be located 

anywhere within range of the 

router; Other computers can cut 

to the Skycut

Skycut can be located 

anywhere within range of the 

computer; Other computers can 

cut to the Skycut

Skycut can be located 

anywhere 

Cons Skycut is physically connected 

to the computer; Cannot be 

accessed by other computers 

at the same time

Requires more steps to set up; 

Some routers may require 

setting changes in order to 

work with the Skycut

Computer is now connected to 

the Skycut, thus no wireless 

access to the Internet or to 

other wireless devices

More steps due to saving and 

then loading the file; Cannot 

adjust size and certain cut 

settings once saved
 

• Note that implementing any of these options does not preclude you from changing to another one, as 
needed. 

• The following sections present what steps are required for each type of connection. If you run into 
connectivity issues, please contact your dealer. 

 
 

1.12.1 USB Connection 

• Begin with the Skycut powered off and the USB cable unplugged from the Skycut.  
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• In SignMaster, click on the Cut, Plot & Engrave Tools icon   (6th from the left on the upper middle 
task bar) and select Vinyl Spooler.  In the window which opens, click on the Connection tab: 

 

 

•  Select Direct USB Port. Then click on Detect.  The following window will open: 

 

• Because you haven’t yet plugged in the USB cable or powered on the Skycut, click on Next: 

Should read 
SKYCUT C16 (or 
the model you have 
purchased) 

Select Direct USB 
Port 

Click on Detect 
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• Connect the USB cable to the right side of the cutter and into an available USB port on your computer. 
Power on the Skycut and wait about 20 seconds. The following window should open without the need to 
click on Next: 

 

• Click on Done in the prior window.  In the Vinyl Spooler window, the Connection name from the prior 
screenshot should now appear next to USB Port: 

 

• Click on Done and proceed to Section 1.13. 
 
 

Click Done  

Connection Name 
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1.12.2 Wi-Fi Connection 

• Note: Not all routers have the same signal strength. It’s usually best to connect the Skycut while it is in the 
same room with the router.  Once connectivity is established, you can then experiment to see how far from 
the router the Skycut can be located.  

• What you’ll need: 

◊ Name of your home/office network 

◊ The password for your network 

• Carefully complete the following steps:   

(1) On the Skycut’s control panel, select Set   and then select Wifi. The Wifi screen will appear:  
 
 
 
 

                           

(2) Click on the Scan button and a list of the available networks will appear. Select your home/office 
network and click on Apply. You will then be returned to the Wifi screen: 

                                    

(3) Click on Set and the following screen will open: 

 

 

Click on Scan  

Click on Wifi  

Click on Set  

Select your 
network 

 

Click on Apply 
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(4) To enter the password, use the following tips if you are unfamiliar with this type of screen: 

◊ “Rapid tap” multiple times in succession to select a letter. For example, if your network password is 
cts456, then to enter “c”, you would tap three times on “abc” because “c” is the third letter in “abc”.  
Next you would proceed to “stu” and tap two times to enter “t”. Then you would only need to tap on 
“stu” once to enter the letter “s.”  

◊ To enter numbers, click on “123” to open the number entry screen. 

◊ For punctuation, click on “#@~“ to open the extra characters screen. 

◊ To enter upper case letters, click on the up arrow in the lower left part of the screen. 

(5) Once you have the password entered in the display box at the top, click on OK to return to the Wifi 
screen:  

 

(6) Next check the IP Address that will be assigned to the Skycut. The Skycut will automatically pick up the 
first three sets of digits from your router but will continue to display them as shown above. You only 
need to decide if the last set, which should be defaulting to “200”, can be used. Use the “+” or “-“ buttons 
to make any needed changes. 

(7) Click on Apply and wait for several minutes while your router assigns this IP Address to the Skycut. 
Eventually, you will see Connected OK appear: 

Delete last 
character 

Password will 
display here 

 

Click OK when done 

 

Toggle to switch between 
uppercase and 
lowercase letters 

Switch to punctuation 

Switch to 
numbers 

Default IP Address 
assigned to Skycut Click on “+” or “-“ buttons to 

change IP Address, if needed 
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(8) If instead of receiving a Connected OK display, you see Password err, again verify the network you 
selected and the password you entered. If you are unable to successfully connect and the Skycut is 
within a few feet of your router, please check your router’s user manual and/or search online for issues 
with your particular router model.  

(9) If you wish to reset and start again, press and hold the Default button for 3 seconds until the button 
turns red. Then click on Scan and repeat from Step 3. 

  

(10)  Once you receive the Connected OK display, in SignMaster, click on the Cut, Plot & Engrave Tools 

icon   (6th from the left on the upper middle task bar) and select Vinyl Spooler.  In the window 
which opens, click on the Connection tab and make the following changes: 

 

• Click on Configure and the following window opens: 

 

 

 

Success! Click on Apply Click on Apply Wait will be displayed for 
several minutes 

Should read 
SKYCUT C16 (or the 
model you have 
purchased) 

Select Windows 
Port 

Click on 
Configure 

Select Port 

Select TCP 
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• Change the IP Address to the one you set up on the Skycut control panel. Click on Test. A Port OK 
message should pop up. Click on OK and then click on Apply: 

         

• The IP Address should now appear in the Vinyl Spooler window: 

 

 

• Click on Done and proceed to Section 1.13. 

 
 

Enter IP Address 
from earlier setup 

Click on Test 

Click OK 
Click on Apply 

 IP Address should 
now be here 

Click on Done 
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1.12.3 Wireless Stand-Alone 

• It’s usually best to connect the Skycut while it is next to the wireless computer.  Once connectivity is 
established, you can then experiment to see how far from the computer the Skycut can be located.  

• There are two situations to consider before getting started. If you are not sure which applies to your Skycut, 
then select B and go to that section first.  

A. The Skycut has never been set up wirelessly to a network. 

B. The Skycut has previously been connected to a wireless network.  

 

A. The Skycut has never been set up wirelessly to a network 

• Power on the Skycut and wait for the light to come on. 

• On your computer, open your list of available networks. In the list, you should see one with this type of name 
format:  HI_LINK_XXXX where “XXXX” can be any alphanumeric combination, such as “92BF” or “08A5”.  

• Select that network and enter the following Network Key when prompted: 12345678. 

• In SignMaster, click on the Cut, Plot & Engrave Tools icon   (6th from the left on the upper middle 
task bar) and select Vinyl Spooler.  In the window which opens, click on the Connection tab and make the 
following changes: 

 

 

• In the prior screenshot, the IP Address is already set to the correct Stand-Alone IP Address: 
192.168.16.254. If this matches what you see, skip the next two steps. Otherwise, click on Configure and 
the following window opens: 

 

 

 

 

Should read 
SKYCUT C16 (or 
the model you have 
purchased) 

Select Windows 
Port 

Click on 
Configure 

Select Port 

Check to see if this is 
already set 

Select TCP 
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• Change the IP Address to 192.168.16.254. Click on Test. A Port OK message should pop up. Click on OK 
and then click on Apply: 

     

• The IP Address should now appear in the Vinyl Spooler window. Click on Done and proceed to Section 
1.13. Remember that your computer will not have access to the Internet or other network devices while in 
Wireless Stand-alone mode. 

 

 

 

B. The Skycut has previously been connected to a network 

• On the Skycut’s control panel, select Set   and then select Wifi. The Wifi screen will appear:  
 

                           

Enter the following 
IP Address  

Click on Test 

Click OK Click on Apply 

Click Area Test to verify 
communication 

Click Done when 
finished 

Press and hold 
Default 

Click on Wifi  
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• To reset the Skycut so that it will be found as an available network, press and hold the Default button for 3 
seconds. Release and you should see the Apply button now displays Wait. In a minute the Apply should 
return and you can then proceed back to A. The Skycut has never been set up wirelessly to a network and 
use the same procedure as if the Skycut was never set up on a network. 

 
 

1.12.4 USB Flash Drive 

• With a USB Flash Drive connection, you will normally follow the steps presented in this section. If you are 
new to SignMaster and/or to your Skycut, it is recommended that you go to Section 1.13 now and set up a 
file using the steps presented there. Then, when you are ready to cut, return to this section.   

• Insert a USB flash drive into your computer and allow Windows to find it. Note the drive letter assigned by 
Windows. 

• Design or open a file in SignMaster. After making any changes to the design, click on the Cut, Plot & 

Engrave Tools icon   (6th from the left on the upper middle task bar) and select Vinyl Spooler.  In the 
window which opens, click on the Connection tab and make the following changes: 

 

 

• Click on the Cut Options tab: 

 

 

 

 

 

 

 

 

 

 

 

 

Should read 
SKYCUT C16 (or 
the model you have 
purchased) 

Select Windows 
Port 

Select Port 

Select U-Disk 
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• For initial testing of your Skycut, it is highly recommended that the test pen be used until you know, with 
certainty, where shapes will draw.  

• After you have entered the settings you plan to use, click on Done and the Vinyl Spooler window will close. 

• Again, click on the Cut, Plot & Engrave Tools icon   (6th from the left on the upper middle task bar) 
and, this time, select Send to Cutter.   

• The following window opens. More about the settings on the left side of the window will be covered in 
Section 2.03. For now, just note where your shape will cut relative to the material and how to initiate the 
exporting of the PLT file: 

Change your 
settings to the 
ones shown 
here 

Select Pen Tool  
for initial testing 

Pen drawing: 
leave unchecked; 
Cutting: Check 
and enter settings 

Click on Done 
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• Click on Cut Now and a confirmation window opens where you have one more chance to note the Force 
and Speed at which the material will be cut. Answer Yes to proceed, No to cancel: 

 

• After selecting Yes, a Save PLT File window opens because earlier you had changed the connection type 
to U_Disk. Browse to locate the USB flash drive you plan to use and name your PLT file: 

 

 

• After saving the file, you can close the Vinyl Spooler window. Insert the flash drive into the right side of the 
Skycut. On the control panel, select USB and then Open File:  

Note where design 
will cut relative to 
where the blade 
holder is positioned 

Click on Cut Now 

This figure assumes 
blade holder is positioned 
in the lower right corner of 
the material 

Locate the USB flash 
drive for saving your files 

Enter a file name 
Click on Save 
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(1) Double tap on USB DISK and a screen will open showing any folders and PLT files on the flash drive. 
Double tap a folder to open it, as needed.  Drag the scroll bar on the right to see more files:  

           

 

(2) Once you have located the PLT file you want to cut, double tap the name. You will be taken back to the 
USB screen and the selected file name will be displayed: 

     

 

Drag here to scroll 

Double tap here 

Press Open File  

Double tap on 
selected file to go 
back to USB screen 

Set up repeats, refer to 
Section 1.14.1  

Click here and 
cutting will begin 
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(3) If you wish to cut repeats of the file, select Array Set and a screen will open where you can then select 
the number of rows and columns of repeats, along with the spacing between the repeats. Refer to 
Section 1.14.1.  

(4) If your project is a print and cut (aka contour cut) application, please refer to Section 3.08.  

(5) When you are ready to cut, click on Start Cut.   
 
 
 

1.13 Test Draw Shapes 

• New owners tend to be VERY eager to try out their Skycut. It’s important to test your cutter to ensure that 
data is being sent properly from your computer to the cutter. The following steps will allow you to do some 
testing with the pen tool. But note that the following steps are for DRAWING, not cutting.  Before 
inserting the blade holder into your cutter, please read the following Sections 1.07.2, 1.07.3, 2.01, 2.02, and 
2.03. 

• It is also very important to understand where shapes will cut based on various available options in 
SignMaster. This is partially addressed in the next section; complete details are covered in Section 2.02.2. 

• Before setting up a file for testing, if you are new to SignMaster, it is recommended that you watch the 

following introductory video:  

• You have two options when using the test pen:  

◊ Insert a sheet of paper directly into the cutter: 

 

◊ Or…Place the paper onto the cutting mat and then insert the cutting mat into the cutter:  

 

Observe how pinch 
wheels are centered with 
white arrows 
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• Before installing the test pen, make sure the pen will write by scribbling on scrap paper. Note that you will 
probably need to remove a tiny bit of wax on the end of the pen nib. Then follow these steps: 

◊ Loosen the screw on the blade holder seat. 

◊ Insert the blade holder allowing it to freely rest on top of the paper.  

◊ Before tightening the front screw, raise the test pen up a little bit (~ 1/8” or several mm).  You don’t want 
the pen still touching the paper but you also don’t want the pen too high above the paper either. 

◊ Tighten the front screw to lock in the test pen. Be careful not to push down on the blade holder seat 
while tightening.  

 

 

 

• Use any of the horizontal markings at the front of the Skycut to align the mat so that it’s straight. Lift the 
pinch lever to drop the pinch wheels onto the cutting mat. Most of the mat and the paper should now be 
behind the cutter, not in the front: 

 

• The arrow keys on the Skycut’s control panel will always be used to set the origin for cutting: 

Only the front part of the 
mat and material will be 
in the front of the 
machine. 

Feed the mat this 
direction into the 
Skycut 

Align the paper along 
one of the grid lines on 
the cutting mat. 

IMPORTANT!  This is NOT the recommended method for loading the blade holder into the cutter. 
This is presented as a quick way to insert the test pen so that it is in a good position for drawing. 
The instructions for inserting the blade holder and setting a blade distance above the material will 
be covered in Section 2.01.3. 
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◊ Click on the buttons or the arrow keys on your keyboard to move the head left or right and the mat in 
and out. The goal is to have the tip of the pen close to the lower right corner of the paper: 

 

          
 

◊ Once the pen tip is in the lower right corner, you are ready to proceed with the test. 

• In SignMaster, on the left side tool panel, press and hold the General Power Shapes icon and, from the 
drop-down menu, select the Arrow option:  

 

• Press and hold the left mouse button and drag the mouse in the Drawing Area to create the arrow shape. 
In this test, it doesn’t matter where you place the arrow on SignMaster’s Drawing Area, as it will be drawn 
at the origin you set on the machine.  

  

Press and hold the 
General Power Shapes 
icon 

 

Select Arrow 

 

Move pen tip 
to this corner 
of the paper. 

Move the pen tip 
to this corner of 
the paper 

Feed the mat this 
direction into the 
Skycut 

The middle button can be 
toggled so that the 
movement is much slower. 

Use these arrows to move 
the mat in and out and 
move the head left and 
right 
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• If you wish to resize the arrow, either drag one of the square handles around the selected arrow or, in the 
settings above the Drawing Area, change the Width or Height, as desired: 

 

• At this point, if you plan to export this file to a USB flash drive, rather than cut directly to the Skycut from 
SignMaster, please go to Section 1.12.4 for instructions.  

• After making any changes to the design, click on the Cut, Plot & Engrave Tools icon  and select 
Send to Cutter. The following window opens. More about the settings on the left side of the window will be 
covered in Section 2.03. For now, just note where the shape will cut relative to the material: 

 

• Before executing the cut/draw process, appropriate settings need to be selected. Click on the Cutter 
Control tab and the following settings will be displayed: 

 

 

 

Width and Height 

 

Note where design 
will cut relative to 
where the blade 
holder is positioned 

Test pen is positioned in 
the lower right corner of 
the material before 
drawing 

Open Blade Settings Library 

Tool settings 

Cut settings 

Click on the Cutter Control tab 
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• Click on the small icon to left of Passes and the Blade Settings Library opens: 

 

 

 

• To switch to the test pen, click the down arrow to the right of Description and select Pen Tool: 

 

         

 

 

• Click on Apply and the Cutter Settings (Tool settings) will update showing a 0.00 setting for Blade Offset 
(more about this setting is covered in Section 2.03.3): 

 

 

• Next, the preset for drawing with the test pen will be selected. Click on the down arrow to the right of Preset 
Condition. In the drop-down menu, select Pen Mode (Tool 0)(Head L). Note that on a dual head cutter, 
there are two options, but on a single head cutter, you will always select Tool 0: 

Select Pen Tool A test pen image appears 

Pen Tool now 
appears here 

Pen Tool should now appear here 

Blade Offset should now read 0.00 

Click down arrow 
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• The Force and Speed settings have now changed to settings appropriate for testing. Note that more about 
these settings will be covered in Chapter 2. 

 

• Click on Cut Now and a confirmation window opens where you have one more chance to note the Force 
and Speed at which the material will be cut. Answer Yes to proceed, No to cancel: 

    
 
  

• After selecting Yes, the Skycut will draw the arrow on your paper: 
 

Select Pen Mode (Tool 0) 
Click down arrow 

Pen Mode is now selected 
Preset settings 
for drawing 

Click Yes and drawing 
will begin 

Click on Cut Now 
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• To draw again, return to the cut window and choose a different origin. Practice moving the origin to different 
locations. If you want to have the arrow draw in a Landscape orientation, then mark the Rotate option. You 
will see the arrow rotate in the Preview: 

 

• Cutting with this setting results in the arrow pointing downwards as shown in the prior preview window: 

 

Feed the mat this 
direction into the 
Skycut 

The arrow is drawn at the origin 
and points to the right.  

Check Rotate 

Note arrow is 
now rotated 

Feed the mat this 
direction into the 
Skycut 

The arrow is drawn at the origin 
and points down  
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• If you want the arrow to draw where you have it located on the Drawing Area, versus at the origin, then you 
need to mark the option called Absolute (position) in the same Send to be Cut window: 

 

 

 

 

 

 

• Set the origin in the lower right corner of the mat’s grid and then place the paper in the correct location on 
the mat to correspond to where the shape is positioned in SignMaster.   Refer to Section 2.02.2 for more 
details on controlling where images will cut. 

 
 
 
 
 

1.14 Default Settings To Consider 

• The Skycut’s control panel offers a number of default settings. Some of these may not be important at this 
point in the learning process. So, you may want to skip this section for now but remember that it’s here and 
could provide you some options to improve your experience with the Skycut. 

• Each of the following sections will refer to one of the settings in the Set screen. 

 
 

IMPORTANT:  Please read Section 2.01 before cutting! 

Check Absolute (position) 

Arrow will now draw in 
this location 

Location of arrow in 
Drawing Area  

Test pen is still positioned in lower right 
corner of material before drawing 
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1.14.1 Advanced Settings 

• The optional settings in the Advanced Settings screen are: 

 
 

• Array: Tap the Array button to open the Array screen: 

     

◊ In the above screenshot, the shape sent to the Skycut would cut 3 across and 7 up & down, for a total of 
21 shapes. The spacing between each shape would be 0.20 inches (Note: to use mm instead of inches, 
switch the Units setting. Refer to Section 1.14.2). 

• Show Point: When toggled on, the Main Screen displays movement and location output based on the 
position of the cutting head: 

Display (X,Y) location of cutting 
head 

Option to use laser engraver 

Set up rows & columns of repeats 

Turn on if you want cutting head 
to move to the far right when 
cutter is powered on 

Separate Cut Speed from Up 
Speed  

Option to change directions on 
up/down keys  

Sizing Calibration 
Refer to Section 2.08 

Tap here to turn on Array      

Spacing between left-to-right repeats 

Number of repeats: left to right 

Number of repeats: up & down 

Spacing between up-&-down repeats 

Repeats for a print and cut application 
Refer to Section 3.08     
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◊ Absolute Location displays the current location relative to a “power-on” location of (0,0):  

o X is the left-to-right location 

o Y is the up-&-down location 

o L is the straight-line distance from (0,0) 

◊ Relative location displays the change in location currently being made as you press the arrow keys: 

o x is the current left-to-right distance moved from X  

o y is the current up-&-down distance moved from Y 

o l is the straight-line distance from the (X,Y) location 

• Up Speed is how fast the blade travels while in the “up” position, such as when it is moving from the origin 
to the location of the first shape to cut or when moving from one cut shape to begin cutting another. When 
turned off, Up Speed will match the SPEED set for cutting. Turning on this setting will change the 
Speed/Force screen to display both speeds, allowing them to have different settings: 

  

                     

• To right power on: With this setting turned on, the cutting head will move to the far right whenever the 
Skycut is powered on.  

• Y Key Mode: This setting controls the movement of the material or cutting mat when using the up and down 
arrows in the Main Screen: 

As arrow keys are tapped, all locations 
will update 

Absolute Location Relative Location 

Speed control for arrows buttons is 
located here when Show Point is on. 
Press to toggle to slow speed when 

needed:  

Press here to reset
Relative Location

Cut Speed 

Up Speed 
Cut and Up 

Speed 

Force 

Force 



 41 

 

 

• System Mode has several options: note the Section numbers for some of these: 

 

• Scale is used is used to input the sizing calibration. Refer to Section 2.08.  
 
 

1.14.2 General Settings 

• The optional settings in the General Settings screen are: 

 

Pressing an UP arrow will move 
the material forward  
 
Pressing a DOWN arrow will 
move material towards the back 
of the cutter 

Pressing an UP arrow will move the 
material towards the back of the 
cutter 
 
Pressing a DOWN arrow will move 
material forward 

Normal cutting/drawing with just 
the blade holder or test pen  

Option to choose when 
laser engraver is used 

Fast Scan Mark (contour cutting) 
Section 3.04.3 

Activating commands  
Appendix B 

Select blackout time for 
screens and end-of-cut alarm 

Set preferred lighting color 

Select preferred language for 
control panel 

Select inches or millimeters 
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• LED set allows you to change the color of the light inside the Skycut. The default is white but you can 
change it by dragging the scroll bars on the LED set screen. For example, if you wanted a blue light, you 
could drag red and green all the way to the left. For a purple light, only drag green all the way to the left, etc. 

                                          

 

◊ Pressing Off All will set R, G, and B to 0 which turns off the light 

◊ Pressing On All will set R, G, and B back to 255 or white light mode. 

• Screen and alarm has three settings: 

◊ Screensaver time: Set a black-out time, in minutes, for the control panel  

◊ Alarm after finish working: When a job is complete, have an alarm sound (five beeps)  

◊ Change the LED: When a job is complete, have the LED light change to blue 

 

 

• Unit allows you to choose either inches or mm for settings such as Show Point and the Spacing setting 
under Array.  

LED light: white LED light: green LED light: purple 

Increase Screensaver time (or 
drag the orange bar) 

Decrease Screensaver time 
(or drag the orange bar) 

Turn on Alarm to beep at end of 
cut  

Turn on Change the LED to have 
light turn blue at end of cut  
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• Language allows you to choose from eight languages to be used throughout the control panel display 
screens: 

 

1.14.3 Sys Information 

• The Sys Information screen displays information about the Skycut and only has three setting changes 
available:  

 

◊ This initial screen displays current version numbers.  

◊ If you ever need to reset your Skycut, press and hold Default All until it turns red. Then wait for the 
button to update to Success! 

◊ If you ever need to change which software is in use with your Skycut, press and hold SOFT for two 
seconds and release. The following screen will open: 

Press and hold to open 
Software Screen 

Model ID’s and version 
numbers 

BAUD setting based on 
software selected  

Press and hold to reset Skycut 
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◊ To use a different software program to cut to the Skycut, press inside the appropriate circle. The Baud 
Rate indicator will automatically change if needed.  

◊ Fast Speed changes the algorithm used for cutting long paths and can shorten the cut time for larger 
projects. However, accuracy is also compromised and this setting would certainly not be advisable for 
print and cut applications or when precise measurements are needed. 

 
 

1.15 Maintenance 

Skycut machines do not require any kind of lubrication or routine checks. However, here are a few things to 
keep in mind for successful operation of your cutter: 

• Keep the pinch wheels clean. Depending on the adhesive being used on the cutting mat, it’s possible for the 
pinch wheels to become sticky and pick up small pieces of cardstock or other material being cut. This can 
lead, in some cases, to the mat skewing or ruining materials during subsequent cuts. To clean the pinch 
wheels, use a lint-free cloth and an adhesive remover such as isopropyl alcohol or Un-Du to clean the pinch 
wheels thoroughly. 

• Keep the grit shafts clean. Equally important as the pinch wheels, the grift shafts beneath the cutting mat 
should also be free of adhesive and tiny bits of material. They can be cleaned the same way as the pinch 
wheels. Note: Do not pour cleaner onto a grit shaft. Instead, dab some adhesive remover onto a lint-free 
cloth and then use the damp cloth to clean the shafts.  You can also use tweezers to remove any material or 
adhesive that is stuck to a shaft. 

• Keep the cutting mat clean and sticky. As mentioned in the Section 1.08.2, the cutting mat can be washed 
with soap and water to remove small invisible pieces of material which are reducing the tackiness of the 
cutting mat. After drying, you can add more repositionable adhesive, if needed. 

• Check your blade holder, as needed. If suddenly you cannot get a clean cut, check the blade holder for any 
tiny slivers of material that may have been caught up by the blade and fed up inside the blade holder.  

• If you cut vinyl or other backed materials regularly, you may need to replace the cutting strip at some point. 
You will be able to tell based on seeing deep cuts in the strip and an inconsistency in the cutting. Contact 
your dealer for information on obtaining a replacement. 

 
 
 

1.16 Other Useful Tools and Supplies 

• The following list has items you may or may not need while enjoying your Skycut. These are suggestions 
based on twelve years of collecting information from other cutter owners: 

◊ Brayer or Rolling Pin: (1) to apply lint from a towel onto an overly sticky mat  (2) to press materials 
evenly onto a mat for cutting 

Software options 

BAUD setting based on 
software selected  

Alternative cutting algorithm: 
read second bullet below 
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◊ Post-It Notes: (1) for setting blade/tool tip height above a material  (2) for draw and cut applications   

◊ Old Fluffy Bath Towel: (1) to dry a washed mat  (2) to apply an invisible layer of lint onto an overly-
sticky mat 

◊ Dishwashing Soap: (1) to remove visible and invisible fibers from the mat, thus renewing the adhesive 
(2) to clean the mat well before adding more adhesive 

◊ Soft Brush: (1) to gently remove waste scraps during the washing of a mat. Refer to Section 1.08.2. 

◊ Artist Palette Knife: (1) to gently remove cut shapes from a mat  (2) to scrape off small waste pieces 
from a mat  

◊ Blue Painter’s Tape: (1) to tape around the edges of thicker materials that might slip during cutting 

◊ Repositionable Adhesives: (1) to add more adhesive to a cutting mat (most any brand or type can be 
used, provided it is repositionable). Refer to Section 1.08.2 for suggestions and instructions. 

◊ Adhesive Removers: (1) to completely strip a cutting mat of adhesive (2) to disarm adhesive long 
enough to remove large scraps of material that will not peel off 

◊ Lint-free Cloth: (1) for dusting off your cutter and cleaning pinch wheels and grit shafts 

◊ Awl or Paper Piercer (or other sharp pointed tool): (1) to pick or lift out a test cut to verify results 

◊ Stabilizers: A stabilizer is an adhesive material that is applied to the bottom of the material you are 
cutting so that cleaner cuts can be achieved. The stabilizer works in one or more of the following ways – 
(1) provides firmer contact with the cutting mat (2) provides a final layer that does not need to be cut if 
the stabilizer will be removed after cutting (3) prevent some slightly-elastic materials from being 
stretched by the blade.  Recommended stabilizers include freezer paper, Thermo-web Heat n’ Bond, 
and Steam-a-Seam 2. 

◊ Double-sided Tape: (1) For securing metal tags or charms to the cutting mat for engraving 

◊ Non-slip Shelf Liner: (1) To place under cardstock and other material when embossing 
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2. Cutting 

 
 
 

2.00 Quick Reference for this Chapter 

• How to properly mount the blade holder: Section 2.01.3 

• How to control which shapes get cut: Section 2.02.1 

• How to control where shapes get cut: Section 2.02.2 

• Understanding Blade Offset and Overcut: Section 2.03.3 and Section 2.03.4 

• How to set a very precise origin: Section 2.05.1 

• How to add weeding lines to a cut: Section 2.06.3 

• How to get shapes to cut to precise dimensions: Section 2.08 

• How to know which settings to adjust to solve cutting issues: Section 2.09 

• Suggested settings for cutting materials: Section 2.11 

 

The Most Common New Owner Mistakes: 

• Too much blade is exposed on the blade holder (material is lifting up and/or tearing) - refer back to Section 
1.07.3 

• The blade tip (or pen nib) is too close to the material (inconsistent cutting) - refer to Section 2.01.3 

• The pinch wheels are not properly positioned (material or mat is sliding around or bunching up during the 
cut) – refer back to Section 1.09 

• Failing to do a test cut (recommended cut settings are not working) – refer to Section 2.01.5 and 2.09 

• Not practicing enough with the test pen and paper (shapes are not cutting in the correct locations) – refer to 
Section 2.02.2 

 
 

2.01 What You Need to Understand About Cutting 
 

2.01.1 You Have to Make Mistakes 

• The key to becoming successful at cutting is to do a lot of it! Those who shy away from using their Skycut 
will never get to the stage of mastering it.  It’s very normal for new owners to be intimidated by their cutter, 
so remember the following key things: 

◊ You won’t break your new Skycut by cutting paper, vinyl, cardstock, and other easy-to-cut materials.  
The worst thing that might possibly happen is that you’ll break a blade. That’s it!  And the likelihood of 
even that happening is low. 

◊ You need to start cutting so that you’ll begin making mistakes. It’s in making these mistakes that you 
start to learn. You realize that these mistakes didn’t result in a broken cutter.  Plus, you’ll stop making 
the same mistakes as you remember more of the things you need to check before every cut.  

◊ As you make fewer mistakes you begin to build confidence and you begin to have more cutting success. 
From there, you begin to experiment more and produce more. Thus, your best course of action is to just 
start cutting… a lot! But first, read the rest of this chapter. 

 
 
 
 

IMPORTANT:  Please read all of 2.01!!! 
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2.01.2 Record Your Successes 

• As you have successful cuts, take note of the settings you just used, such as Force, Speed, blade type, 
number of passes, brand of material, etc. There is a blank form in Section 2.10 that you can print and use to 
record your results.  There are also suggested settings for common materials at the end of this chapter. Use 
these as starting guides but remember that your results may vary based on the many factors which can 
affect cutting. 

 

2.01.3 Set the Blade Height Above the Material   

• The Blade Height is the distance from the tip of the blade to the top of the material you are about to cut.  
You have control over that height and will need to raise the blade holder up a little higher before locking it 
into place with the screw on the blade holder seat. 

• Adjust the blade height so that: 

◊ The blade tip will not be dragging across the material you are cutting when moving to the point to begin 
the cut. This will ensure that the dropping of the blade will invoke more downward force… to a point!  

 

 

◊ In Section 1.13.2, you were instructed to raise the test pen a small distance above the material. 
However, this isn’t a very accurate method and does not necessarily optimize the cutting force on the 
Skycut. 

◊ The recommended method for getting the same height set from one cut to the next is to use a spacer of 
some kind: 

o Place the spacer on top of the material you are cutting, with the material loaded into the Skycut.  

o Loosen the screw on the blade holder seat and insert the blade holder so that the tip of the blade is 
touching the top of the spacer: 

 

o Now tighten the front screws carefully making sure you are NOT pushing down on the blade holder 
seat. Once tight, remove the spacer.  You should feel the blade gently scratching the top of the 
spacer. 

o This distance will provide the blade some “punch room” to give extra force and more consistent 
cutting of your material.    

◊ What to use for this spacer?   

o Post-It notes which are the same thickness as 20 lb (75 gsm) copy paper work well.  

o For materials such as cardstock, vinyl, and fabric, use 20 Post-It notes or 20 sheets. This is ~ 2 mm.  

 

Perfect Height         Too Low    Too High 

Blade tip needs to 
be above the 
material 
 

But not too high or blade tip 
will not reach the material 
when dropped. 
 

Blade tip just touches 
top of spacer 

Spacer is on top of material 
which is on top of mat 
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o When cutting thin chipboard with the red blade, use 20 Post-It notes. When cutting any material with 
the blue blade, only use 15 Post-It notes.  

o For very thick materials, such as balsa or craft foam, use 10 Post-It notes. Note that you do not 
want the rim of the blade holder mounted above the black tool-holder piece. Otherwise, the blade 
will not reach the material or will be too high to apply the needed pressure for cutting. 

o The table at the end of this chapter includes a column for blade height based on the number of 
Post-It note sheets used by the testers.  

                          

 

 
 

2.01.4 Adjust the Speed, Force, and Number of Passes Based on the Material and Shapes 

• Using correct cut settings is equally important as the type of blade, blade length, and blade height. Refer to 
Section 2.03 for details. Suggested settings are located at the end of this chapter and settings for using the 
various Skycut accessory tools are located at the end of Chapter 4. 

 
 

2.01.5 Perform Test Cuts! 

• You have two options: 

(1) Perform the built-in test cut on the Skycut itself using the Test option on the Main Screen or from within 
the Speed/Force Screen. 

(2) Select any basic shape and size it to be around 0.3” – 0.5” (~ 8 mm – 13 mm): 

o I personally like using a design with an internal shape, such as a ring. You can then easily see if the 
blade is cutting into the mat (or into the backing sheet on rolled materials) when you lift out the cut 
shape and observe where the internal shape cut. To locate a ring, click on the General Power 

Shapes icon  on the left side Tool Panel and go to Basic Shapes>Basic.  

o When cutting intricate shapes, use a small letter or a shape will lots of sharp turns for testing. For a 
rhinestone project, use a small portion of your rhinestone pattern as a test. 

• There is a flow chart in Section 2.09 which will help you determine which settings to change when test 
cutting a material.  

 

2.01.6 Keep the Cutting Mat Clean and Sticky 

• Press your materials evenly to the mat.  Consider using a brayer both before AND after cutting. Repressing 
the material after cutting can greatly aid in weeding the cut shapes from the waste. 

• When necessary, tape thicker materials to the mat to keep them from slipping during the cut.  

• If you cut a range of materials, you might need more than one mat so that you can use stickier mats for 
certain materials. 

• Refer back to Section 1.08 for information on cleaning the cutting mat and adding more adhesive, 
 
 

Use 20 for cardstock, vinyl, fabric Use 15 with blue blade and for 
slightly thicker materials 

Use 10 for thick materials like craft 
foam and balsa 
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2.01.7 Don’t Get Frustrated, Get Help! 

• Besides having your own Skycut dealer as your first line of contact, there are other resources where you 
can ask questions and get answers. Utilize the resources listed in Section 1.01. 

 
 

2.02 Choices Before Cutting 

• There are a number of factors under your control for cutting: 

◊ What shapes to send to the cutter: Section 2.02.1 

◊ Where the shapes will be cut from the material: Section 2.02.2 

◊ What tool(s) will be used for cutting (or drawing, scoring, engraving, etc.): Section 2.02.3 

◊ What settings will be used: Section 2.02.4 
 
 

2.02.1 Controlling Which Shapes Will Cut           

• There are three ways to control whether a shape will be cut or ignored. In explaining these options, the 
following shapes have been added to the Drawing Area. Note that this file (called Controlling What Cuts) is 
shared in a zip file available here.  

 

◊ Option 1: If no shapes are pre-selected, then all shapes will be sent to cut. However, if you pre-select, 
for example, only the “Skycut” and the arrow, then only those shapes will appear in the Send to be Cut 
Preview: 

        

o A more common practice is to select all objects of one color and only have those shapes sent to cut. 
To do this, go to Edit>Select by>Color (or use the shortcut key “S”) and the following window will 
open where you can, for example, mark Red to be selected. Then the Preview will only have 
“Skycut”, the red circle and the red star present: 

 

These two 
shapes are 
selected 

Only those two 
shapes appear in 
Preview 
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o Along the same lines, you can select all objects of type and only have those shapes sent to cut. To 
do this, go to Edit>Select by>Object Type (or use the shortcut key “O”) and the following window 
will open where you can, for example, mark Circle and Star. Then the Preview will only have 
circles and the stars present: 

   

 

o Note that the icon at the top of the screen:  will open a menu where you can then access the 
same Select by Color or Select by Type options: 

 

Mark the box 
by Red Only the red 

shapes appear in 
Preview 

It’s also noted here that 
only red shapes are 
selected 

Click on OK 

Mark boxes for 
circles and stars Only the circles 

and stars appear 
in Preview Click on OK 

Click on the Select by icon 
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◊ Option 2: Mark shapes not to be cut on the Objects tab of the Page Thumbnail Viewer:  

o To access the Objects tab, click on the small icon to the left of the Palette: 

`      

o Select a shape, such as the arrow. On the Object tab, it can then be set not to cut: 
 

 

                            

 

 

 

Click this blue 
arrow 

Click the Objects tab 

All of the shapes 
appear in a list 

Arrow is 
selected 

Arrow will not cut Click this icon to 
turn off cutting 

Arrow is no longer in Preview 
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◊ Option 3: Cutting can be controlled by color from within the Send to be Cut window. Click on the 
Separate by Color option and a drop-down menu will appear: 

 
 

o In the Preview window, shapes with the current color from the menu appear. Also, the color is 
selected at the top: 

 
 

o Switching to blue changes the window accordingly: 

 

o Note that you can also change colors by clicking on those colored rectangles above the preview. 

Drop-down menu 
of colors used in 
the project 

Mark the 
Separate by 
Color option 

Black is selected 
in the drop-down 
menu 

Black is outlined here 

The one black object is the 
only shape shown in the 
Preview 

Blue is selected 
in the drop-down 
menu 

Blue is now outlined 

The two blue objects now 
appear in the Preview 
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2.02.2 Controlling Where Shapes Will Cut 

• This was briefly covered in Section 1.13 where the Rotate and the Absolute (position) options were 
introduced.  

◊ Default: Moves the shapes to align with the origin you have set based on the blade tip. 

◊ Absolute (position): Cuts the shapes where they are positioned on the Drawing Area.  

◊ Print and Cut (aka Contour Cutting): Cuts the shapes relative to where registration marks are 
scanned: 

o This is the mode used when you want to print images on your printer and then have the Skycut cut 
them out.  

o Registration marks are printed, along with your images. The printout is placed into the Skycut and a 
built-in camera automatically locates and aligns with each printed mark. The Skycut will then cut out 
your shapes based on triangulation. This is far more precise than Absolute (position) because it 
takes into account not only any misalignment of your printout in the cutter, but also any errors in the 
printing. Most printers do not print images precisely in the location on the paper as they are located 
on the screen. 

o Note that raster images (.JPG, .BMP, .PNG etc.) will need to be traced first so that cut lines are 
created.  Section 3.04 will present an example.  

o Refer to Chapter 3 for complete instructions on calibrating the camera and examples of PNC 
applications.  

 

• You can also rotate a design for cutting, relative to how it appears on the Drawing Area: 

◊ To rotate the project, go to Send to be Cut and mark the Rotate option: 

 

◊ For example, in a project with long text, it is more convenient to view and edit the text in a left-to-right 
orientation: 

 

◊ However, when you then send this project to the Preview window, you will observe that it is too wide to 
cut from left to right on your Skycut: 
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◊ Marking the option for Rotate will then rotate the design and allow the project to cut: 

 

 
 
 

2.02.3 Selecting the Tool to be Used for Cutting 

• To select the tool you’ll be using, open the Send to be Cut window and click on the Open Blade Settings 
Library icon:   

 

• The Blade Settings Library window will open. Click on the down arrow to the right of Description where 
you can access a drop-down menu for the Blade Type: 

 

The red lines and dimensions 
also indicate the project 
cannot be cut 

Project is too wide to 
cut left-to-right 

The black lines and dimensions 
indicate the project can now be cut 

Rotated project will now fit 
within the width of the machine 

Click on this icon 
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• Selecting one of the options, such as 45 degree blade will display an image of the blade, the Blade Offset 
and Overcut assigned as a Preset: 

   

• Sections 2.03.3 and 2.03.4 will explain Blade Offset and Overcut settings. Section 2.04 will explain how to 
modify these settings, if needed and save as a Preset. 

       

2.02.4 Determining the Cut Settings  

• There are three locations where Cut Settings can be entered: 

◊ Send to be Cut>Cutter Control tab (which was covered in Section 1.13) 

◊ Send to be Cut>General tab  

◊ Vinyl Spooler>Cut Options tab  

• Send to be Cut>General 

◊ Use this location when you need to assign different settings to different layers of your project. For 
example, let’s say you wanted to use the embossing tool to score lines in a popup card, followed by 
cutting out the card itself. Or, another example would be using the test pen to draw a design and then 
cutting a contour around it. Under General Options, Assign Tools by Color is marked and then, below 
that in the Cutting Tool Presets section, individual colors can be highlighted and cut settings assigned 
by selecting a Preset or by clicking on Edit: 

 

 

Click here 

Tool menu 

Color of cap on a 
Skycut 45 degree 
blade 

Presets for Blade Offset and Overcut 
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◊ More details for using this feature are covered in Sections 4.01.1 and 4.02.2.  

• Vinyl Spooler>Cut Options 

◊ Use this option as an alternative to entering settings via the Cutter Control tab. It can be accessed from 
the Properties button in the Send to be Cut window. You will also use it in print and cut (contour cut) 
applications to check and adjust cut settings as well.  

 

◊ In the Vinyl Spooler window, click on the Cut Options tab and the cut settings are located in the lower 
section of that window: 

 

• These settings should be understood thoroughly, as you will be adjusting them often as you change 
materials or as your blade dulls over time. Note the prior screen shot shows the section number to go to for 
more information. 

Section 2.03.2 

Section 2.03.4 

Section 2.03.3 

Section 2.03.1 

Click Properties to open 
Vinyl Spooler window 

Mark Assign Tools by Color 

A color is selected 

A Preset is selected or settings 
can be entered by clicking on Edit 
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• The table at the end of this chapter contains recommended settings for your initial test cut. If you cannot find 
your material in the table, use the flow chart in Section 2.09 while test cutting your material to determine 
optimum settings.   

 
 
 

2.03 Cut Settings 

• Before presenting the various settings, note that the Force and Speed settings can be set on the control 
panel itself. In order to cut from SignMaster and use the settings on the Skycut, uncheck these boxes in 
either of the two places where the settings can be made: 

◊ Send to be Cut>Cutter Control window: 

 

◊ Vinyl Spooler>Cut Options window: 

 

 
 

2.03.1 Cutting Force 

• Cutting Force (also called Pressure) ranges from 1 to 160 where the maximum of 160 represents ~850g of 
cutting force. If it is set too low, the material cannot be cut. If it is set too high, you will get bad cutting (even 
incomplete cutting at times) and tearing of the material. Use suggested settings for the material you are 
cutting and perform small test cuts before cutting your actual project. Make adjustments in order to get a 
clean test cut before proceeding with your larger cut. 

• Dull blades will need more force than new blades, thus anticipate increasing the force over the life of the 
blade. 

• When cutting materials that can use either blade, the 45o blade (red cap) will need a little more force than 
the 60o blade (blue cap), because of the extra contact with the material being cut and because the 60o blade 
is cut much thinner, making it a “sliver blade.” 

• As noted earlier, this setting can be made on the Skycut control panel instead. Press the Force/Speed icon 

 and then set the FORCE to the desired level. 
 
 

2.03.2 Cutting Speed and Travel Speed 

• Cutting Speed (also called Down Speed) is how fast the blade travels while it is in the “down” or cutting 
position. Travel Speed (also called Up Speed) is how fast the blade travels while in the “up” position, such 
as when it is moving from the origin to the location of the first shape to cut or when moving from one cut 
shape to begin cutting another.  

• The Skycut has 13 speed settings ranging from “snail’s pace slow” to “insanely fast.”  

Uncheck these boxes if Speed and 
Force settings on Skycut are to be used 

Uncheck these boxes if Speed and 
Force settings on Skycut are to be used 
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◊ The settings from 1 through 4 are the slow speeds and should be used when cutting dense difficult 
materials, such as chipboard, craft plastic, styrene, and balsa. 

◊ The settings from 5 through 8 are medium speeds and should be used for easy-to-cut materials, such 
as cardstock, vinyl, iron-on transfer, and rhinestone template material. 

◊ The settings from 9 through 12 are the fast speeds and are useful for engraving, embossing, and 
drawing.  You may, however, find that some materials will cut well at the faster speeds. 

• Cutting Speed is usually more important to control since the blade may need more contact time with a 
particular material. Travel Speed can usually be left quite high although, for print and cut accuracy, it may 
need to be lowered if there are many shapes to be cut from a printout.  

• IMPORTANT: At the current time, the Travel Speed does not function from SignMaster. Thus, if you need a 
separate Cut Speed and Up Speed, please use the control panel for this setting. 

• On the Skycut control panel, the default setting is to have the Up Speed and Cut Speed the same and 

referred to as SPEED. This can be adjusted by pressing the Force/Speed icon  and then setting the 
SPEED to the desired level.  In order to enter a separate Up Speed on the control panel, refer to Section 
1.14.1. 

 
 

2.03.3 Blade Offset 

• Blade Offset is the horizontal distance from the center of the blade shaft to the tip of the blade.  A pen or 
engraving tool has an offset of 0 because the tip is centered with the center of the pen/engraving tool shaft. 
But a blade is different: 

 
  

 
  
 
 
 
 

• If you set the Blade Offset to 0 when cutting with a blade, corners will be rounded. On the other hand, if it is 
set too high, bubbles will be cut on sharp corners: 

  
 
 

 
 
  
 
 
 

• Below are the approximate Blade Offset settings to use for each of the three types of Skycut blades: 

◊ Red capped blade: 0.3 mm 

◊ Blue capped blade: 0.4 mm 

◊ Yellow capped blade: 0.75 mm 

• Any time you order new blades, check for the recommended Blade Offset on the packaging.  However, it’s 
not unusual for blades to be slightly off-spec. 

• SignMaster has two built-in Blade Offset calibration routines which can be used to determine the best 
Blade Offset setting for the current blade in use. Here are the steps to access either one: 

Offset is too low: 
corners are rounded 

Offset is too high: bubbles 
appear at the corners 

Imagine a line 
passing through 
the center of the 
test pen or 
blade 

The Offset is the distance 
between the center of the 
blade holder and the tip of the 
blade. 

There is no 
Offset on a 
pen. 
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◊ Select the material you want to use for testing, such as vinyl, paper, or cardstock. Note how much 
material will be needed for the test you select and add a few inches to these dimensions: 

o Normal Test: Width: ~9” (354 mm)   Height: ~3.5” (89 mm) 

o Quick Test: Width: ~4.5” (114 mm)   Height: ~1” (25 mm) 

◊ Install the blade you wish to calibrate into the blade holder and mount the blade holder in the Skycut. 
Enter appropriate settings in SignMaster or on the Skycut control panel. Test cut a small shape to make 
sure the settings are correct.  

◊ Go to the Vinyl Spooler window and select the Calibrations tab. 

◊ Click on the Blade Offset icon and a new window opens: 

 

  

 

 

◊ In both tests, the instructions on the screen will guide you on how to enter the best result and then will 
display the recommended Blade Offset to use. This new Blade Offset value will then be updated in the 
cut settings. Instructions on how to add this setting as a Preset are covered in Section 2.04. 

 
 

2.03.4 Overcut 

• Overcut is related to Blade Offset in that it isn’t needed when using a pen, embosser, engraver, and so 
forth, because the tips of those tools are aligned with the center of the tools themselves. However, leaving 
Overcut at 0 when using the blade holder will result in large shapes not quite closing: 

  
 
 
 
                             
                       

• In some cutting programs, Overcut is not a separate setting but rather automatically calculated and applied 
based on the Blade Offset entered. However, in SignMaster, you can enter an actual Overcut setting and 
should do so any time a blade is used.   

• In general, the blade type doesn’t greatly affect the Overcut required. Try using 1.00 mm. In the event you 
cut a large closed shape, like an 8” circle, you may find that you’ll need to increase Overcut to 2.00 mm.  
 
 

2.03.5 Passes 

• The Passes setting causes each individual path to be cut the set number of passes before the blade moves 
to the next path to cut. This is better than just repeating the entire cut as each repeated pass is cut with the 
blade held down throughout the repeated passes, resulting in cleaner cutting. 

• The Passes setting is not present in the Vinyl Spooler>Cut Options window. Thus, you’ll need to make 
changes in the Send to be Cut>Cutter Control window: 

Overcut is too low: 
paths do not close 

1. Select 
Calibration tab 

4. After loading material and 
verifying cut settings on the 
Skycut, click here.  

3. Select either Normal Test 
or Quick Test (note material 
requirements below) 

2. Click on Blade 
Offset icon 
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• In general, when increasing Passes, the Cutting Force setting can be decreased. For example, you may 
find a cardstock that requires a Cutting Force of 55 to cut in a single pass will only need a Cutting Force of 
45 if cutting in two passes. 

• Passes is recommended in the following situations: 

◊ Cutting thicker denser materials, such as chipboard, where multiple passes allow the blade to 
progressively “carve” through the material 

◊ Cutting certain fibrous materials, such as fabric, where a second pass will ensure that all of the fibers 
have been cleanly cut 

◊ Cutting intricate or detailed shapes (such as script titles) from certain materials, such as heavy or 
textured cardstock, where a single pass may leave certain spots not cleanly cut 

◊ Cutting rhinestone template material where a second pass results in much cleaner weeding of the cut 
circles 

• IMPORTANT:  In the current version of SignMaster Pro, Passes does not work if Assign Tools by Color is 
activated. Therefore, if you have a project requiring separate settings for layers, such as a score and cut 
project, the two processes should be performed as separate jobs. 

• Alternatively, passes can be set on the control panel by pressing the USB button on the main screen and 
you will see a Passes Set button in the window which opens: 

 

• Press the Passes Set button to open the following screen where you can turn on the Passes function and 
enter the desired number of repeats: 

 

 

 

 

 

 

Change Passes here 

Press Passes Set 

NOTE: If your screen does not 
have Passes Set displayed, 
please go to Appendix B for 

activation instructions. 
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• IMPORTANT: Currently the Activate Passes option will default to unmarked (off) whenever the Skycut is 
first powered on. Thus, make a mental note (or, even better, put a Post-It note on your cutter) to turn this 
option on when needed. Also, note that when this setting is activated, it will take precedence over the 
Passes setting in SignMaster. 
   

 
 

2.04 Presets 

• Presets allow you to save your settings for a particular blade type or material.  

 

2.04.1 Saving a Preset for a Blade Type 

• Let’s say you conducted the calibration for Blade Offset in Section 2.03.3 and determined it to be 0.40 for 
your red capped blade. To save this setting as a preset, use the following steps: 

• Go to the Send to be Cut>Cutter Control window and click on the icon to the right of Blade Offset to open 
the Blade Settings Library:  

 

 

• In the Blade Settings Library, click on the + icon to the right of Description and a window will open where 
you can enter the name for your new preset: 

 

 

 

Open Blade Settings Library Click on the Cutter Control tab 

Use + and – buttons to enter 
number of Passes 

Mark this option to activate Passes 
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• Click on OK and then select which blade type you are using for this new preset Enter the new Blade Offset 
and Overcut values. Then click Update: 

  

• Click on Apply to close the Blade Settings Library. The new preset will now be available for selection in 
the Description menu.  

• If you need to delete a preset, select it from the Description menu and click on the “-“ icon to the right. 

 

2.04.2 Saving a Preset for a Material 

• IMPORTANT: As was noted in Section 2.02.4, Up Speed (aka Travel Speed) is not functional in 
SignMaster. Thus, if you need a separate Cut Speed and Up Speed for a particular material’s preset, it is 
recommended that the preset be made on the control panel.  

• Similar to the blade holder preset, you can enter settings for a particular material. For example, let’s say you 
cut Georgia Pacific 110 lb cardstock at a Force of 55 and a Speed of 8. Use the following steps to create a 
new preset in SignMaster: 

• Go to the Vinyl Spooler>Cut Options window and click on Edit Presets: 

 

3. Click on Update 
2. Enter new Blade Offset 
and Overcut values 

1. Select type of blade 

4. Click on Apply 

Enter a new name Click on + 

Click on Edit Presets 



 63 

• The SKYCUT C16 window opens. Click on the + icon to the right of the current Preset Mode name and a 
window will open where you can enter the name for your new preset: 

 

          

                      

• Click on OK and then complete the rest of the window with the settings for that material:  

 

 

• Click on Apply to update the Preset Mode menu with this new listing. Click on Done to close the Vinyl 
Spooler window.  The new preset will also now be available in the Send to be Cut>Cutter Control window, 
in the Preset Condition menu: 

 

 

 

 

 

 

 

 

Enter a new name Click on + 

Select Blade Preset 

Make all necessary changes 
to settings 

New Preset name 

Click on Apply 
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• If you need to delete a preset, return to Vinyl Spooler>Cut Options>Edit Presets window, select the 
preset from the Preset Mode window click on the “-“ icon to the right: 

 

• Presets can also be saved on the Skycut control panel. To create a preset: 

◊ Press the Force/Speed icon  to open the Force/Speed screen: 
 

 

◊ Make the necessary changes to the SPEED and FORCE settings. Select Save and the following screen 
opens: 

Adjust settings by sliding bar 
or using + and - buttons 

Click on Save 

Select new preset here 

Settings are 
updated based on 
Preset selected 

Click on “-“ icon to 
delete preset 
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◊ Press one of the unused preset boxes, e.g. name5, and it will turn blue indicating it is highlighted. Select 
Rename.  

◊ A window opens where you can enter the name for the new Preset. The characters are entered in the 
same manner as the Password entry window in Section 1.12.2.  Note that there is a 15 character limit. 
Click on OK when done. 

 

 

◊ You will now see the name of your new preset and you can press Save to add it to the saved presets 
with the FORCE and SPEED you set.  You will be returned to the Force/Speed screen. 

Delete last 
character 

New preset name 
will display here 

 

Click OK when done 

Toggle to switch between 
uppercase and 
lowercase letters 

Switch to punctuation 

Switch to 
numbers 

Select an 
unused box Select 

Rename 
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◊ To verify the preset or to select a different preset, press Preset. The Preset window opens where you 
can see all of the Presets, along with the settings for those presets.  In that window you can also select 
a different preset. Then you can select Rename to edit its name or select Load to select that preset’s 
Force and Speed into the Force/Speed screen. 

   

 

 

 

 

 

2.05 Setting the Origin before Cutting 

• Before you cut, you should check to see where the blade tip is located in relation to the material so that the 
shapes will cut in the appropriate location. 

• IMPORTANT! The C16 Skycut has a maximum cutting width of 16 inches. If you move the head too far to 
the left to begin the cut and your project is wide, you may exceed the left side limit and cutting will stop at 
that point with no option but to abort.  

• To set the origin, press the arrow buttons on the main screen of the control panel. Remember that the 
middle button can be toggled between regular speed and a slow speed for more control: 

Select 
Preset 

Select Rename to 
edit the name 

Select Load to change 
Speed and Force to 
these settings  

Press Save 

New Preset 
name 
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• In general, you set the origin near the lower right corner of the material, as you did during your initial test 
drawing in Section 1.13.  

 

2.05.1 Setting an Origin Using the Camera           

• In the event you need to set an extremely precise origin, the Skycut’s built-in camera can be used: 

(1) Go to Section 3.03 and perform the camera calibration.  

(2) Choose where you want the origin to be set. You’ll need an “origin target” to use when the camera takes 
a photo. It can be a dot on your material, the corner of your material, the intersection of grid lines on the 
mat, etc. If you do choose the latter, make sure there’s a way to clearly distinguish which intersection 
you want to use. 

(3) On the Skycut’s Main Screen, use the arrows to move the center of the blade holder roughly over the 
origin target. In this example, a dot will be used. 

(4) Select Set and Camera. In the Camera Screen, press OK. A photo will be taken and displayed. If 
needed, press X3 so that you are zoomed out and able to see the origin target (dot) in the photo: 

 

 

(5) Press the center of the origin target in the photo so that the red + will be moved approximately over it: 

Press here to 
toggle origin 
setting speed 

Origin Target (dot) 

Red + 

Blue dashed + 
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(6) Press OK. In the new photo, the blue dashed + should be close to the origin target. Press X3 to zoom 
in: 

   

 

(7) Use the arrow buttons to move the red + as close as possible to the center of the origin target: 

 

(8) Press OK. At this point the blue dashed + should be centered with the origin target: 
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(9) Press the Home icon to return to the Main Screen. The head should move so that the blade holder is 
now located over the origin target and you can proceed with the cutting process. 

 
 

2.06 Other Cut Setting Functions  

• There are other functions and features available in the Send to be Cut window that may be useful 
depending on your application. Some have already been covered. Some will be covered in this section. 
Others will be covered in later parts of this manual. Note the section numbers for reference: 

 
 
 

2.06.1 Advance Mode  

• The Advance After Plot option in SignMaster Pro is actually controlled on the Skycut itself. The function 
can be opened by going to Set>Advance Mode on the control panel. 

 

 

◊ to start will cause the blade holder to return to the origin after cutting. 

◊ to end will cause the blade holder to advance forward to the end of the cut project. 

◊ to left will cause the blade holder to move to the left of the cut project. 

Use “-“ and “+” buttons to 
set an advance amount 

Select from these 
three options 

Section 3.03 

Section 2.06.1 

Section 2.02.2 

Section 2.02.1 Option 3 

Section 4.01.1 

Section 2.06.3 

Section 2.02.2 

Section 2.06.3 

Section 2.06.3 

Section 2.06.4 

Section 2.06.3 

Section 2.06.2 
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◊ The settings below the option are activated when choosing either to end or to left. You can enter a 
specific distance for the blade holder to advance. This is useful when cutting repeats of the same 
project because it allows for the origin to be set automatically for the next repeated cut. 

 
 

2.06.2 Mirror 

• Checking the Mirror option will apply a horizontal mirror to the shape (s) before cutting. This is useful in 
applications such as: 

◊ Cutting HTV in which the material is placed faced down so that the heat protection layer is not 
penetrated by the blade 

◊ Cutting vinyl to be applied to the inside of a car or home window but primarily viewed from outside of the 
window 

◊ When cutting certain non-homogenous paper materials in which cutting upside down yields cleaner 
results 

   
 
 
 
 
 

2.06.3 Weeding Options 
 

• For those cutting vinyl and HTV, the weeding options in SignMaster are worth noting. 

◊ Auto Weed-Box: Marking this option places a single weed box around the entire project: 

   

 

 

o Note: to change the size/offset of the weed box around the design, click on the Settings tab and 
adjust, as desired: 

 

 

 

 

 

Before applying Mirror After applying Mirror 

Before applying Auto Weed-Box After applying Auto Weed-Box – blue 
border around design indicates weed cut 
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◊ Auto Speed-Weed: Marking this option places a single weed box around the entire project with an 
additional horizontal weed line through the middle: 

 

   
 
 
 
 
 

◊ Easy-Lift Weed Marks: Marking this option adds hooked lines to shapes with internal paths to make it 
easier to lift with a weeding tool: 

   

 

 
 

◊ Speed-Weed Text Only: Mark this option when your design has a combination of both text and other 
shapes so that only the text will have Speed Weed applied: 

Change offset here 

Click Settings tab 

Before applying Auto Speed-Weed After applying Auto Speed-Weed – blue weed 
box plus horizonal weed cut in the middle 

Before applying Easy-Lift Weed Marks After applying Easy-Lift Weed Marks – 
hooked cuts are added to internal shapes for 
easy lifting during the weeding process 
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2.06.4 Weld Text 

• For script fonts, the Weld Text option will remove overlap between letters so that a word will cut as one 
object. For example, if you go to View>Wireframe, you can see the overlap that will be cut when a script 
font is used: 

 

• You have the option to select the letters and apply the Weld function under the Shaping and Welding 

Tools , thus removing overlap between letters: 

 

• This, however, means you cannot change the font used or alter the spacing of the letters, etc., without 
applying Undo. Therefore, the Weld Text option allows you to cut the text as if the Weld function has been 
applied: 

   

 

 

 
 
 

2.07 Important Checklist Before You Cut! 

• Do you have your material on the mat and the mat inserted into the Skycut?  (Note: materials with a backing 
sheet, such as vinyl and iron-on transfer do not require a mat for cutting) 

Before applying Weld Text After applying Weld Text – overlap 
between letters is removed 

Before applying Speed-Weed Text Only After applying Speed-Weed Text Only – 
text object has additional weed box plus 
horizontal cut through the middle 
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• Do you have the pinch wheel lever raised (so that the pinch wheels are down)? 

• Have you set the blade length based on the thickness of the material you are cutting? 

• Do you have the blade holder firmly mounted in the blade holder seat and the blade tip at the correct height 
above the material? 

• Have you set the Origin (location of the blade tip) at the bottom right corner of your material (or wherever 
you need the origin to be)? 

• Have you set the Force?    And the Speed? 

• Have you selected the correct Blade Offset for the blade you are using? 

• Do you need to turn on Passes for this material? 

• Do you see the correct shapes in the preview window? 

• Do you need to select Rotate, Mirror or Absolute (Position) options? Do you know, with confidence, where 
your shapes are going to cut? 

• Do you need to apply any weeding options? 

 

 

2.08 Scale Calibration 

• If you were to cut out any particular shape, for example, a 10” x 10” square, you might find that it actually 
measures 9-15/16” x 10-1/32”. It will be very close to 10” x 10” but perhaps just slightly smaller or larger in 
either or both dimensions. Now this might be perfectly acceptable for the type of cutting you do. Therefore, it 
may not even be necessary to do this particular calibration.  However, if you do want to make sure your 
shapes are cut precisely to scale, the following procedure will allow you to calibrate your Skycut. 

• The calibration process can be conducted in inches, cm, or mm.  Both mm and inches will be presented 
here. In general, it is recommended that mm be used, however, if you do not have a metric ruler, then you 
can use inches instead.  

• Before beginning this calibration, make sure the Scale setting on the Skycut itself is still set to 1.0 and 1.0. 
On your Skycut control panel, go to Set>Advanced Settings> Scale. The following window opens where 
you can check the current X Scale and Y Scale values: 

 

 

• Return to the main screen. Then pick one of the two following sections and follow the instructions.  

 

2.08.1 Scale Calibration Using Millimeters for Measurement 

• SignMaster has a built-in resolution routine which can be used to easily perform this calibration: 

Verify X Scale and Y Scale 
are both set to 1.0000 

Use the + and – buttons to adjust 
the numbers, if needed  
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◊ Go to the Vinyl Spooler window and select the Calibration tab.  

◊ Click on the Cutter Scale icon: 

 

 

◊ A new window opens where you can enter the dimensions of a square or rectangle to draw with the test 
pen. It is highly recommended that the dimensions be at least 200 mm. Note that in the current version 
of SignMaster, the display in this window is always in inches. However, you can enter values in mm by 
typing in “mm” after the number as shown:  

 
 

◊ Press the tab key and the 200 mm will be automatically converted into inches. Repeat with Length: 

 
 

1. Select the 
Calibration tab 

2. Click on the Cutter Scale icon 

Type in 200 mm 
exactly as shown 

Width has been 
converted to in 

Click here to start 
the drawing 

Type in 200 mm 
exactly as shown 
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◊ On the Skycut, load a sheet of paper and insert the test pen. Move the test pen to the lower right corner 
of the paper. Make sure you have proper settings for drawing and click on Cut Test to have the shape 
drawn.  

◊ Using a mm ruler, carefully measure the Width (left-to-right) and the Length (top-to-bottom) that drew:   

 

◊ Write these measurements onto your sheet: 

 

◊ These values can now be entered into the same Width and Length fields, again adding “mm” after 
each number as shown: 

         

 

 

Width, X 

Length, Y 

Feed the mat this direction 
into the Skycut 

Enter actual Width and 
add “mm” 

Enter actual Length 
and add “mm” 


